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DESIGNING STAT BLOCKS

Use these notes to design your stat blocks. Refer to page
5 for a blank stat block template and page 6 for example
stat blocks. Feel free to use or modify the example stat
blocks for your adventure.

FORMATTING NOTES

Blank Sections: Delete any entries not relevant to the
creature. For example, if the creature has no spell-like
abilities delete that section.

Colon: The only uses of a colon are at the end of the
(CL xx) expression for spells and spell-like abilities.

Semicolon: Use a semicolon between headers of
equal weight in the same paragraph—for example,
between Init and Senses, hp and DR, Space and Reach. In
the Senses line, use a semicolon between any special
sensory abilities and the creature’s Listen and Spot
modifiers. Also, use a semicolon between spell levels in a
spellbook listing.

Text Styles

The new stat block uses four styles of text. Do not use or
invent any other styles in your stat blocks. The stat block
already includes the correct styles in the correct listings.

Stat Block Title: Use this style for the title of the
stat block.

Stat Block Text: This is the default style of the stat
block.

Stat Block Calculation: Use this style to show your
math. Such sections utilize hidden text to split this
information out from the normal parts of the stat block.
Delete any categories not relevant to the creature. For
example, if the creature does not have a synergy bonus
for a given skill, delete that section.

To view hidden text in Word click Tools > Options >
View tab > Hidden Text. To hide hidden text reverse the
procedure.

After inserting hidden text, check to make sure that
the stat block’s formatting is still correct. Sometimes
extra spaces creep in between normal and hidden text
which moves commas and such. Bare this in mind when
checking your formatting.

To print hidden text click File > Print > Options >
Hidden Text.

Stat Block Spell Style: Use this style when listing
prepared and memorized spells as well as spell-like
abilities.

WHAT GOES WHERE

Use these notes to determine where to list feats from
non-core sources. Always mentions feats in a given
section before listing any other entries.

Speed: Flyby Attack, Spring Attack, Ride-By Attack,
Shot on the Run, Run

AC: Dodge, Mobility, Deflect Arrows, Two-Weapon
Defense

Atk Options: Awesome Blow, Blind-Fight, Cleave,
Combat Reflexes, Far Shot, Great Cleave, Improved Bull
Rush, Improved Disarm, Improved Feint, Improved
Overrun, Improved Precise Shot, Improved Sunder,
Improved Trip, metamagic feats (if the creature can cast
spells spontaneously), Mounted Combat, Point Blank
Shot, Power Attack, Powerful Charge, Precise Shot,
Quick Draw, Rapid Reload, Spirited Charge, Stunning
Fist, Trample, Whirlwind Attack.

Special Actions: Snatch Arrows

IDENTIFICATION AND ENCOUNTER

The top section identifies the creature and gives the
information you need at the start of an encounter.

Name: This word or phrase identifies the creature.
If there is more than one of the creature include in
brackets how many of the creatures are encountered.

CR: This value is the Challenge Rating of an
individual creature of this kind.

Race, Class, and Level: Only provide this
information for characters with class levels. Use an
asterisk to denote non-core items. On the next line
indicate the class or race’s source; for example, *Complete
Arcane 6

Alignment: The one- or two-letter abbreviation
denotes the creature’s alignment.

Size and Type: The creature’s size category and its
type (and subtype or subtypes, if applicable) are given
here. Capitalize the size category of the creature (for
example, Large) but not the creature’s type or subtype.

Init: This value is the creature’s modifier on
initiative checks.

Senses: Alphabetically list whether the creature has
darkvision, low-light vision, scent, tremorsense,
blindsense, blindsight, or some other sensory special
quality. This information is followed by the creature’s
modifiers on Listen and Spot checks (even if the creature
has no ranks in those skills).

Aura: Occasionally, a creature has a special ability
that takes effect anytime another creature comes
within a certain distance of it. Examples include a
blackguard’s aura of despair or a devil's fear aura. Only list
auras that effect combat here; list all others in the SQ
section.

Languages: List alphabetically the languages the
creature speaks or understands, followed by any special
abilities relating to communication (such as telepathy or
tongues) that it possesses. Capitalize languages.

DEFENSIVE INFORMATION

This section provides the information you need when
characters are attacking the creature.

AC: This entry gives the creature’s Armor Class
against most regular attacks, followed by its touch and
flat-footed AC. If the creature has feats or other abilities
that modify its Armor Class under specific circumstances
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(such as the Mobility feat), they are noted here as well as
in the Feats entry.

hp: This entry consists of the creature’s full normal
hit point total (assuming average rolls on each Hit Die),
followed by the creature’s Hit Dice in parentheses. If the
creature has fast healing, regeneration, damage reduction
(DR), or some other ability that affects the amount of
damage it takes or the rate at which it regains hit
points, that information also appears here.

Immune: List alphabetically any immunities the
creature has here. This includes immunity to specific
types of energy as well as specific immunities (such as
immunity to poison or to sleep effects).

Resist and SR: If the creature has resistance to
certain kinds of attacks, list that information
alphabetically here. Resistance to energy is shown first, as
the energy type and the number of points resisted per
attack (acid 10, for example). This information is
followed by any other resistances the creature has. The
creature’s spell resistance, if any, appears after the
other resistances on the same line.

Fort, Ref, Will: This entry gives the creature’s
saving throw modifiers.List modifiers applying to any
specific attack type after a semi-colon. For example, +2
against enchantment.

Weakness: This entry details (alphabetically) any
weaknesses or vulnerabilities the creature has, such as
light sensitivity or vulnerability to a type of energy.

OFFENSIVE INFORMATION

Refer to this section when it's the creature’s turn to act
in combat. All its combat options—from melee attacks
to spells to potions it might drink—appear in this
section, even if they are not strictly offensive in nature.

Speed: This entry usually begins with the creature’s
base land speed, in feet and in squares on the battle grid.
If the creature is wearing armor that reduces its speed,
note that speed first and its base speed is given afterward.
Next come speeds for its other modes of movement, if
applicable.

Melee/Ranged: Typically, these entries give all
the physical attacks the creature can make when taking a
full attack action. The first attack described is the
creature’s preferred form of attack, usually a melee
attack of some sort but possibly (as in the example below)
a ranged attack. If the creature can make only a single
attack (for instance, when it is taking an attack action), use
the first indicated attack bonus. Occasionally, a creature
has separate options indicated for single attacks and for
full attacks. List Manyshot and Rapid Shot here along
with the effects they have on the creature’s attacks. For
example, a halfling ranger with the Manyshot and Rapid
Shot feats might have the following entries:

Ranged +1 longbow +8 (2dé6+2/[ts]3) with Manyshot
or

Ranged +1 longbow +10/+10/+5 (1d6+1/[ts]3) with
Rapid Shot or

Melee mwk longsword +8/+3 (1d6/19—20)

Bach set of attack routines is prefaced by a boldface
word indicating whether the attacks are melee or
ranged. Next comes the weapon used for the attack, the
modified attack bonus, the amount of damage the attack
deals, and information about critical hits. If the weapon
has the “default” critical hit characteristics (20/x2), this
portion of the entry is omitted.

Space: This entry defines how large a square the
creature takes up on the battle grid. Omit this
information for any creature that occupies a s-foot
square.

Reach: The Reach entry defines how far the
creature’s natural reach extends, and it also gives
information about any reach weapons it might use. Omit
this information for any creature that has a reach of s
feet.

Base Atk: The Base Atk entry gives the creature’s
base attack bonus without any modifiers.

Grp: This entry gives the creature’s grapple bonus
(base attack + size modifier + Str bonus + Improved
Grapple [if applicable)).

Atk Options: Special abilities that the creature
can employ to modify its normal attacks appear here.
Such abilities might include feats such as Power Attack
or Combat Expertise, or special abilities such as smite evil
or trip. List feats (alphabetically) before any other
abilities.

Special Actions: This entry lists alphabetically any
special attacks that the creature can use on its turn in
place of making its melee and ranged attacks.

Combat Gear: Possessions that the creature can
choose to employ on its turn as an action appear here.
Such items might include doses of poison (applied
poisons, not natural ones), scrolls, potions, wands,
staffs, rods, or wondrous items. Include the CL of an
item if it is not the minimum needed to craft the item.
All items that have charges, or that allow saves, should
contain the relevant information. List alphabetically.

Spells Prepared: Use this entry for wizards, clerics,
and members of other classes who prepare spells. It
begins with the character’s caster level for spells. If its
rolls to overcome spell resistance are based on a number
other than its caster level (because the creature has the
Spell Penetration feat, for example), its total modifier
appears after the expression “spell pen.” List spells from
highest level to o-level. Included a bracketed attack
bonus and saving throw DC for appropriate spells. If the
character casts some spells at a different caster level than
others, include that information with the affected spells.

A cleric’s statistics block also includes the name of
his deity and the domains to which he has access. Each
domain spell he has prepared is marked with a
superscript D. The granted powers of his domains might
appear as combat options or resistances, or they might
not appear at all (if they only modify information
presented elsewhere).

List spells alphabetically (ignoring any metamagic
feats applied to the spell). Spell names should be
italicized and lower case except for an individual's name
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(for example, Bigby). Do not italicize the names of any
metamagic feats applied to a spell.

Spells Known: Use this entry for spellcasters, such
as sorcerers, who do not prepare spells. See “Spells
Prepared,” above for more information.

Spell-Like Abilities: Any spell-like abilities the
creature possesses appear here. The entry begins with
the creature’s caster level for these abilities. As with
spells, this entry includes attack bonuses and saving
throw DCs where appropriate. List from highest to
lowest spell level.

OTHER INFORMATION

Most of the information presented in this section is not
relevant during a combat encounter with the important
exception of explanatory text detailing special abilities
that appear elsewhere in the statistics block.

Abilities: The creature’s ability scores appear here in
the customary order (Str, Dex, Con, Int, Wis, Cha).

SQ: Any special qualities not presented earlier in the
statistics block appear here.

Feats: List the creature’s feats alphabetically,
including those that appear elsewhere in the statistics
block. Always capitalize feat names, except any portion
of the name appearing in parenthesis. Use the stat
block calculation text style to note at which level the
creature gained each feat.

Skills: This entry shows all the skill modifiers
for skills in which the creature has ranks. Modifiers are
also provided for skills to which racial modifiers,
bonuses from synergy, or other modifiers apply, whether
or not the creature has ranks in those skills. Use the stat
block calculation text style to list the bonuses to each
skill as laid out in the stat block template.

Possessions: This entry is simply a list of items that
the creature is wearing or carrying. The expression
“combat gear plus” appears first, when applicable, to
remind you of other possessions that are referenced
above.

Spellbook: This entry gives the spells in the
creature’s spellbook, if it has one. The notation “spells
prepared plus” indicates that the spells the creature has
prepared are part of this list, but are not reiterated here.

Special Abilities: The final portion of the statistics
block consists of paragraphs explaining special abilities
noted in the various entries above, in the order in which
they appear.

Skills Text that mentions a racial bonus on one or
more skill checks and explains any conditional bonuses
that might apply. This is the last boldface head in this
section of the stat block.
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STAT BLOCK TEMPLATE

MONSTER NAME CR XX SEecial Attack/Quality (XX)
Gender race class level Skills
*list non core race or class source
AL Size type (subtype)
Init +X; Senses Listen +X, Spot +X
Aura
Langages Common
AC XX, touch XX, flat-footed XX
(+/-X size, +/-X Dex, +X class, +X armor, +X shield, +X
deflection, +X insight, +X natural)
Miss Chance
hp XX (XX HD); regeneration/fast healing; DR
Immune
Resist ; SR XX
Fort +X (+x against poison), Ref +X, Will +X
Weakness

Speed xx ft. in armor type (xx squares), base movement xx ft.,
other movement mode XX ft.
Melee weapon +X (damage) or/and

Ranged weapon +X (damage)
Space X ft.; Reach X ft.
Base Atk +X; Grp +X
Atk Options
Special Actions
Combat Gear
Class Spells Prepared (CL Xth):
gth—
8th—
7th—
6th—
sth—
4th—
3rd—
2nd—
Ist—
o—
D: Domain spell. Deity: XX. Domains: Name, Name
OR
Class Spells Known (CL Xth):
oth (x/day)—
8th (x/day)—
7th (x/day)—
6th (x/day)—
sth (x/day)—
4th (x/day)—
3rd (x/day)—
2nd (x/day)—
1st (x/day)—
o (x/day)—
¥ Already cast
Spell-Like Abilities (CL Xth):
3rd—
2nd—
Ist—
{ Already cast
Abilities Str XX, Dex XX, Con XX, Int XX, Wis XX, Cha XX
sQ
Feats Feat, Feat, Feat, Feat, Feat
Skills Skill +#, Skill +#, Skill +#, Skill +#,
Possessions combat gear plus
Spellbook spells prepared plus o—

Special Attack/Quality (XX)
Special Attack/Quality (XX)
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EXAMPLE STAT BLOCKS

CAPTAIN MAINWAR

Male gnome fighter 5

LN Small humanoid (gnome)

Init +3; Senses low-light vision; Listen +1, Spot +4
Languages Common, Goblin, Gnome

CR 5

AC 17, touch 10, flat-footed 17; +4 against giant type opponents
(+1 size, -1 Dex, +6 armor, +1 shield)

hp 42 (s HD)

Fort +7, Ref +o, Will +3; +2 against illusions

Speed 4o ft. (8 squares)

Melee mwk battleaxe +9(1d8+9/x3)

Ranged composite longbow +3 (1d8+4/x3)

Base Atk +2; Grp +8

Atk Options Power Attack, rage 1/day (8 rounds)
Combat Gear potion of shield of faith (+2)

Speed 15 ft. in chainmail (3 squares), base speed 20 ft.

Melee +1 short sword +10 (1d4+5/x3) or

Melee halberd +8 (1d8+3/x3)

Ranged mwk composite shortbow +6 (1d4+2/x3)

Base Atk +5; Grp +3

Atk Options +1 on attack rolls against kobolds and goblinoids

Combat Gear potion of cure modevate wounds, potion of shield of
faith (+2)

Spell-Like Abilities (CL 1st):
1/day—dancing lights, ghost sound (DC 11), prestidigitation,
speak with animals

Abilities Str 14, Dex 8, Con 16, Int 13, Wis 10, Cha 12

SA +1 on attack rolls against kobolds and goblinoids

SQ gnome traits

Feats Blind Fight, Improved Initiative, Iron Will, Weapon
Focus (short sword), Weapon Specialization (short sword)

Skills Climb +2, Intimidate +9, Listen +1, Spot +4, Swim -3

Possessions combat gear plus +1 chainmail, light steel shield, +1
short sword, halberd, masterwork composite shortbow (+2 Str)
with 20 arrows

DIRE RAT (6) CR 1

N Small animal
Init +3; Senses low-light vision, scent; Listen +5, Spot +5

Abilities Str 22, Dex 13, Con 21, Int 10, Wis 10, Cha 6

SQ fast movement, gnoll traits, illiteracy

Feats Improved Initiative, Power Attack

Skills Climb +7, Jump +11, Listen +5, Spot +5

Possessions combat gear plus chain shirt, masterwork
battelaxe, daggers (3), composite longbow (+4 Str), 20 arrows,
backpack, waterskin, flint & steel, bedroll.

When not raging, the gnoll barbarian has the following
changed statistics:

AC 16, touch 11, flat-footed 15

hp 28 (3 HD)

Fort +8, Will +o

Melee mwk battleaxe +7(1d8+6/x3)

Grp +6

Abilities Str 18, Con 17

Skills Climb +5, Jump +9

GNOLL PRIEST CR 2

Female gnoll cleric 2

CE Medium humanoid (gnoll)

Init -1; Senses Listen +7, Spot +8

Languages Gnoll

AC 16, touch 9, flat-footed 16

(-1 Dex, +4 armot, +2 shield, +1 natural)
hp 30 (4 HD)
Fort +9, Ref +1, Will +6

AC 15, touch 14, flat-footed 12
(+1 size, +3 Dex, +1 natural)

hp 16 (3 HD)

Fort +4, Ref +6, Will +4

Speed 4o ft. (8 squares), climb 20 ft.
Melee bite +7 (1d4 plus disease)
Base Atk +2; Grp -2

Abilities Str 10, Dex 17, Con 12, Int 1, Wis 12, Cha 4

SA disease

Feats Alertness, Weapon Finesse®, Weapon Focus (bite)

Skills Climb +11, Hide +8, Listen +5, Move Silently +4, Spot +5,
Swim +11

Disease (Ex) Filth fever—bite, Fortitude DC 12, incubation
period 1d3 days, damage 1d3 Dex and 1d3 Con.

Skills Dire rats have a +8 racial bonus on Swim check and a +8
racial bonus on Climb checks (and can always take 10 on
Climb checks). They use their Dexterity modifier for Climb
and Swim checks.

GNOLL BARBARIAN CR 2

Male gnoll barbarian 1

CE Medium humanoid (gnoll)

Init +5; Senses darkvision 6o ft.; Listen +5, Spot +5

Languages Gnoll

Speed 30 ft. in (6 squares)

Melee mwk morningstar +7 (1d8+3)

Ranged shortbow +1 (1d6/x3)

Base Atk +2; Grp +5

Special Actions spontaneous casting, rebuke undead 3/day (+o,
2d6+2, 2nd)

Combat Gear necklace of fiveballs (2x 3d6, 1x 5d6), scroll of cure
light wounds, longstrider, cure moderate wounds, and remove
paralysis

Cleric Spells Prepared (CL 2nd):
1st—bless, command (DC 14), magic weapon, protection from

goodP
o—cure minoy wounds (2), detect magic, guidance
D: Domain spell. Deity: Erythnul. Domains: Evil, War

AC 14, touch 9, flat-footed 13
(+1 Dex, -2 class, +4 armor, +1 natural)

hp 34 (3 HD)
Fort +10, Ref +1, Will +2

Abilities Str 17, Dex 8, Con 16, Int 8, Wis 16, Cha 10

SQ spontaneous casting, rebuke undead 3/day (+o, 2d6+2, 2nd)

Feats Lightning Reflexes, Alertness, Weapon Focus
(morningstar)®

Skills Knowledge (religion) +o, Listen +7, Spot +8, Spellcraft +o

Possessions combat gear plus chain shirt, heavy steel shield,
masterwork morningstar, shortbow with 20 arrows, 50 gp

GNOME MERCENARY CR 1

Male gnome warrior 2

LN Small humanoid (gnome)

Init +0; Senses low-light vision; Listen +1, Spot -1

Languages Common, Gnome

AC 17, touch 10, flat-footed 17; +4 against giant type opponents
(+1 size, +5 armor, +1 shield)
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hp 13 (2 HD)
Fort +5, Ref +o, Will -1; +2 against illusions

Speed 15 ft. in chainmail (3 squares), base speed 20 ft.

Melee short sword +3 (1d4/19-20) or

Melee halberd +3 (1d8/x3)

Ranged shortbow +4 (1d4/x3)

Base Atk +2; Grp -2

Atk Options +1 on attack rolls against kobolds and goblinoids

Spell-Like Abilities (CL 1st):
1/day—dancing lights, ghost sound (DC 10), prestidigitation,
speak with animals

Abilities Str 11, Dex 11, Con 14, Int 9, Wis 8, Cha 10

SA +1 on attack rolls against kobolds and goblinoids

SQ gnome traits

Feats Weapon Focus (shortbow)

Skills Hide +1, Jump -8, Listen +1, Spot -1, Ride +2, Swim -4

Possessions combat gear plus chainmail, light metal shield,
short sword, shortbow with 20 arrows

GNOME MERCENARY SERGEANT
Male gnome watrior 4

LN Small humanoid (gnome)

Init +1; Senses low-light vision; Listen +2, Spot -1
Languages Common, Gnome

CR 3

Abilities Str 15, Dex 15, Con 16, Int 10, Wis 12, Cha 8

Feats Combat Expertise, Exotic Weapon Proficiency (bastard
sword), Improved Initiative, Weapon Focus (bastard sword)

Skills Intimidate +5, Listen +1, Ride +6, Spot +1, Swim -6

Possessions combat gear plus masterwork half-plate,
masterwork tower shield, shortspear

HOBGOBLIN BATTLE MASTER

Male hobgoblin fighter 1/sorcerer 8

LE Medium humanoid (goblinoid)

Init +6; Senses darkvision 60 ft.; Listen +4, Spot +1
Languages Common, Goblin

CR o

AC 21, touch 11, flat-footed 20

(+1 Dex, +8 armor, +1 shield, +1 natural)
hp 52 (9 HD)
Fort +8, Ref +7, Will +5

AC 18, touch 11, flat-footed 17; +4 against giant type opponents
(+1 size, +1 Dex, +5 armor, +1 shield)

hp 26 (2 HD)

Fort +6, Ref +1, Will +o; +2 against illusions

Speed 15 ft. in chainmail (3 squares), base speed 20 ft.

Melee mwk short sword +6 (1d4/19-20) or

Melee halberd +5 (1d8/x3)

Ranged mwk shortbow +8 (1d4/x3)

Base Atk +4; Grp +o

Atk Options +1 on attack rolls against kobolds and goblinoids

Combat Gear 2 potions of cure light wounds

Spell-Like Abilities (CL 1st):
1/day—dancing lights, ghost sound (DC 10), prestidigitation,
speak with animals

Speed 30 ft. (6 squares)
Melee morningstar +6 (1d8+1)
Ranged light crossbow +7 (1d8/19-20)
Base Atk +5; Grp +6
Atk Options Still Spell
Special Actions
Combat Gear brooch of shielding, potion of cure moderate wounds,
lesser metamagic rod of enlarge spell, scroll of eagle’s splendor,
invisibility sphere, wand of dispel magic (1o charges)
Sorcerer Spells Known (CL 8th):
4th (3/day)—dimension door
3rd (6/day)—fireball (DC 16), fly
and (7/day)—false life, invisibility, scorching ray (+7 ranged
touch)
1st (7/day)—grease, magic missile, protection from good, ray of
enfeeblement (+7 ranged touch), true strike
o (6/day)—dancing lights, detect magic, ghost sound (DC 13),
mage hand, message, prestidigitation, touch of fatigue, read magic

Abilities Str 11, Dex 12, Con 14, Int 9, Wis 8, Cha 10

SA +1 on attack rolls against kobolds and goblinoids

SQ gnome traits

Feats Weapon Focus (shortbow)

Skills Hide +1, Jump -8, Listen +2, Spot -1, Ride +2, Swim -4

Possessions combat gear plus chainmail, light metal shield,
masterwork short sword, masterwork shortbow with 20
arrows

HOBGOBLIN ELITE WARRIOR

Male hobgoblin fighter 3

LE Medium humanoid (goblinoid)

Init +6; Senses darkvision 6o ft.; Listen +1, Spot +1
Languages Common, Goblin

CR 3

Abilities Str 12, Dex 15, Con 16, Int 10, Wis 8, Cha 17

SQ bat familiar, share spells, speak with bats

Feats Alertness® (if familiar within s ft.), Eschew Materials,
Improved Initiative, Still Spell, Lightning Reflexes, Weapon
Focus (ray)

Skills Concentration +14,Listen +4, Move Silently +1, Spot +1,
Spellcraft +11, Ride +4

Possessions combat gear plus amulet of natural armor +1, cloak of
resistance +1, morningstar, light crossbow with 10 bolts,
masterwork full plate, masterwork buckler, spell component
pouch, 50 gp

HOBGOBLIN SOLDIER CR 2

Male hobgoblin warrior 3

LE Medium humanoid (goblinoid)

Init +1; Senses darkvision 6o ft.; Listen +2, Spot +2

Languages Common, Goblin

AC 22, touch 10, flat-footed 22; Combat Expertise
(+0 Dex, +8 armor, +4 shield)

hp 25 (3 HD)

Fort +6, Ref +3, Will +2

AC 19, touch 11, flat-footed 18
(+1 Dex, +6 armor, +2 shield)

hp 19 (3 HD)

Fort +5, Ref +2, Will +1

Speed 20 ft. in half-plate (4 squares), base movement 30 ft.

Melee mwk bastard sword +5 (1d10+2/19-20) or

Melee shortspear +3 (1d6+2)

Ranged shortspear +3 (1d6+2)

Base Atk +3; Grp +5

Atk Options Combat Expertise

Combat Gear oil of magic weapon, potion of cure moderate
wounds,

Speed 20 ft. in banded mail (4 squares), base movement 30 ft.
Melee mwk longsword +6 (1d8+1/19-20)

Ranged heavy crossbow +4 (1d10/19-20)

Base Atk +3; Grp +4

Combat Gear potion of cure light wounds

Abilities Str 13, Dex 13, Con 14, Int 9, Wis 10, Cha 8
Feats Alertness, Weapon Focus (longsword)
Skills Jump -7, Listen +2, Move Silently -4, Spot +2
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Possessions combat gear plus banded mail, heavy steel shield,
masterwork longsword, heavy crossbow with 20 bolts, 10 gp

MONK BODYGUARD

Male human monk 5

LN Medium humanoid (human)
Init +7; Senses Listen +10, Spot +10
Languages Common

CR 5

(+1 Dex, +4 armor)
hp 30 (12 HD)
Fort +6, Ref +7, Will +14

AC 18, touch 17, flat-footed 15
(+3 Dex, +3 class, +1 deflection, +1 natural)
hp 27 (s HD)
Immune normal diseases
Resist evasion
Fort +5, Ref +7, Will +6 (+8 against enchantment spells and
effects)

Speed 4o ft. (8 squares)

Melee unarmed strike +5 (1d8+1) or

Melee unarmed strike 4/+4 (1d8+1) with flurry of blows

Ranged light crossbow +6 (1d8/19-20)

Base Atk +3; Grp +8

Atk Options Stunning Fist 6/day (DC 14), flurry of blows, ki
strike (magic)

Combat Gear potion of cure moderate wounds

Speed 30 ft.
Melee mwk dagger +6 (1d4-1/19-20)
Base Atk +5; Grp +4
Combat Gear potion of cure moderate wounds (2), potion of cure
serious wounds, staff of abjuration (5 charges), wand of stoneskin
(5 charges)
Wizard Spells Prepared (CL 12th):
6th—analyze dweomer (DC 22), globe of invulnerability, greater
dispel magic, true seeing
sth—break enchantment, Mordenkainen’s private sanctum ",
Rary's telepathic bond, teleport, wall of stone
4th—detect scrying !, dimension door, fly, scrying (2), stoneskin
3rd—clairvoyance/claivaudience, hold person (2), magic circle
against evil, protection from energy (2)
2nd—bluy, detect thoughts (DC 18), invisibility, mirror image,
protection from arrows, see invisibility, touch of idiocy
1st—charm person, expeditious retreat, mage armor ' (2), obscuring
mist, shield (2)
o—detect poison (2), message, prestidigitation, resistance
{ Already cast

Abilities Str 13, Dex 16, Con 12, Int 10, Wis 14, Cha 8

SA flurry of blows, ki strike (magic), Stunning Fist

SQ slow fall 20 ft.

Feats Deflect Arrows, Improved Grapple, Improved Intiative,
Stunning Fist, Weapon Focus (unarmed strike)

Skills: Balance +8, Climb +4, Jump +12[, Listen +10, Sense
Motive +7, Spot +10, Tumble +13

Possessions combat gear plus amulet of natural armor +1, ving of
protection +1, light crossbow with 10 bolts

OGRE SHOCK TROOPS

Male ogre fighter 2

CE Large giant

Init +1; Senses darkvision 6o ft.; Listen +2, Spot +3
Languages Common, Giant

CR 5

AC 22, touch 10, flat-footed 21

(-1 size, +1 Dex, +6 armor, +1 shield, +5 natural)
hp 53 (6 HD)
Fort +11, Ref +2, Will +1

Speed 30 ft. in banded mail (6 squares), base movement 4o ft.

Melee mwk greatsword +12 (3d6+10)

Ranged javelin +5 (1d8+7)

Space 10 ft.; Reach 10 ft.

Base Atk +5; Grp +16

Atk Options Improved Bull Rush (+15), Improved Overrun
(+15), Power Attack

Abilities Str 25, Dex 12, Con 18, Int 8, Wis 10, Cha 4

Feats Improved Bull Rush, Improved Overrun, Power Attack,
Weapon Focus (greatsword)

Skills: Climb +2, Listen +2, Spot +3, Swim -3

Possessions combat gear plus masterwork banded mail,
buckler, masterwork greatsword, 2 javelins

SHALFEY CR 12

Human male abjurer 7/loremaster 5

N Medium humanoid (human)

Init +1; Senses arcane sight, darkvision 60 ft., see invisibility;
Listen +4, Spot +4

Languages Abyssal, Celestial, Common, Draconic, Flan,
Infernal, permanent comprehend languages, read magic, tongues

Abilities Str 8, Dex 12, Con 10, Int 22, Wis 14, Cha 13

SQ lore (+11), lore of true stamina, permanent resistance, secret
knowledge of avoidance, secrets of inner strength

Feats Brew Potion, Craft Wand, Craft Staff, Craft Wondrous
Item, Magical Aptitude, Scribe Scroll, Skill Focus
(Knowledge [arcana)),

Skills Concentration +15, Craft (alchemy) +14, Knowledge
(arcana) +23, Knowledge (architecture and engineering) +7,
Knowledge (dungeoneering) +7, Knowledge (geography) +7,
Knowledge (history) +11, Knowledge (local) +8, Knowledge
(nature) +7, Knowledge (nobility and royalty) +7, Knowledge
(religion) +7, Knowledge (the planes) +21, Listen +4,
Profession (astronomer) +17, Spellcraft +25, Spot +4, Use
Magic Device +4

Possessions combat gear plus headband of intellect +4, spell
component pouch, dagger

Spellbook (bared schools evocation and necromancy) Shalfey
has access to an extensive library containing all o-6th-level
spells from the PH

TARL
Male human evoker 5
NG Medium humanoid (human)
Init +1; Senses Listen +3, Spot +3
Languages Ancient Suel, Common, Draconic, Flan, Gnome
AC 15, touch 11, flat-footed 14

(+1 Dex, +4 armor)
hp 22 (5 HD)
Fort +4, Ref +4, Will +6

CR 5

AC 15, touch 11, flat-footed 14

Speed 30 ft. (6 squares)
Melee dagger +1 (1d4/19-20)
Ranged light crossbow +3 (1d8/19-20)
Base Atk +2; Grp +1
Combat Gear potion of cure moderate wounds, potion of invisibility,
scroll of mage armor, eagle’s splendor, silversheen, wand of
fireball (10 charges)
Wizard Spells Prepared (CL sth):
3rd—daylight, dispel magic, fiveball (DC 18)
2nd—flaming sphere (DC 17), protection from arrows, scorching
ray (+3 ranged touch), see invisibility
1st—burning hands (DC 16), hold portal, mage armor
missile (2)

H magic
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o—detect magic, light, message (2), read magic
{ Already cast

Abilities Str 9, Dex 13, Con 14, Int 16, Wis 12, Cha 10

SQ share spells, weasel familiar

Feats Alertness® (if familiar within s ft.), Craft Wand, Greater
Spell Focus (evocation), Scribe Scroll, Skill Focus
(Concentration), Spell Focus (evocation)

Skills Concentration +13, Knowledge (arcana) +13, Knowledge
(architecture  and  engineering)  +4, Knowledge
(dungeoneering) +4, Knowledge (geography) +4, Knowledge
(history) +8, Knowledge (local) +5, Knowledge (nature) +4,
Knowledge (nobility and royalty) +4, Knowledge (religion)
+4, Knowledge (the planes) +8, Listen +3, Spellcraft +13, Spot
+3

Possessions combat gear plus cloak of resistance +1, Quaal’s
feather token (swan boat), dagger, light crossbow with 10 bolts

Spellbook (barred schools: illusion, necromancy) spells
prepared plus o—all; 1st—grease, identify, shocking grasp,
unseen servant, 2nd—eagle’s splendor, rope trick, spider climb;
3rd—Dblink, lightning bolt

WYVERN SKELETON CR 5
NE Huge undead
Init +6; Senses darkvision 6o ft.; Listen +0, Spot +0

AC 13, touch 10, flat-footed 13

(-2 size, +2 Dex, +3 natural)
hp 65 (10 HD); DR 5/bludgeoning
Immune cold, undead immunities
Fort +3, Ref +5, Will +5

Speed 20 ft. (4 squares)
Melee bite +7 (2d8+4) or
Melee bite +7 (2d8+4) and
sting +2 (1d6+4) and
2 wings each +2 (1d8+2) and
2 talons each +2 (2d6+4)
Space 15 ft.; Reach 10 ft.
Base Atk +5; Grp +17

Abilities Str 19, Dex 14, Con -, Int -, Wis 10, Cha 1
Feats Improved Initiative
SQ undead traits

HOBGOBLIN ELITE WARRIOR CR 3
Male hobgoblin fighter 3

LE Medium humanoid (goblinoid)

Init +6; Senses darkvision 6o ft.; Listen +1, Spot +1
Languages Common, Goblin

AC 22, touch 10, flat-footed 22; Combat Expertise
(+0 Dex, +8 armor, +4 shield)
hp 25 (3 HD)
Fort +6, Ref +3, Will +2Speed 20 ft. in half-plate (4 squares),
base movement 30 ft.
Melee mwk bastard sword +5 (1d10+2/19-20) or
Melee shortspear +3 (1d6+2)
Ranged shortspear +3 (1d6+2)
Base Atk +3; Grp +5
Atk Options Combat Expertise
Combat Gear oil of magic weapon, potion of cure moderate wounds

Abilities Str 15, Dex 15, Con 16, Int 10, Wis 12, Cha 8

Feats Combat Expertise, Exotic Weapon Proficiency (bastard
sword), Improved Initiative, Weapon Focus (bastard sword)

Skills Intimidate +5, Listen +1, Ride +6, Spot +1, Swim -6

Possessions combat gear plus masterwork half-plate,
masterwork tower shield, shortspear
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